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第一部分 实验课程的一般要求

一、课前准备

1．上课前应阅读本指导手册中相应的实验课程部分，明确实验课程的内容和要求。

2．根据实验内容阅读教材中的有关章节，弄清基本概念和方法，使实验能顺利完成。

二、上课须知

1．遵守课堂纪律，注意聆听指导教师的讲解。

2．实验过程中的具体操作应按指导手册的规定进行，如遇问题要及时向指导教师提出。

3．实验过程中的仪器故障必须及时向指导教师报告，不可随意自行处理。

4．不得随意删除计算机中操作系统或安装软件。

5．记录实验过程中结果和现象。

三、课后要求

1．实验完成后，要检查计算机是否正常关机。

2．及时完成实验报告并上交给指导教师。实验报告包含实验目的、实验内容、实验过程和步骤，综合性实验还应包括实验结果分析。
第二部分 实 验 项 目

实验一    ArcView GIS入门

实验类型：验证性实验
实验目的：通过ArcView GIS软件的实例演示与操作，初步掌握主要工具、菜单命令的使用。
实验内容：通过打开两个专题图层来熟悉ArcView GIS软件的基本菜单和工具 
实验过程：

1．启动ArcView。ArcView创建了一个空的Project（图1-1），并打开Project窗口。为了加载Spatial Analyst扩展模块，点击File下拉菜单并选择Extensions。Extensions对话框列出了计算机上装有的扩展模块，每个模块旁都有一个复选框（图1-2）。点击Spatial Analyst，一条短信息出现在下方，它描述了Spatial Analyst的功能。对Spatial Analyst打钩，点击OK退出。
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图1-1　　　　创建一个空的Project
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图1-2　　　　加载Spatial Analyst扩展模块
2．ArcView以等级结构组织它的对象。一个Project可使用5个文件：View、Table、Chart、Layout和Script。View显示地图，Table显示表格数据，Chart用图表显示数据，Layout用于生成地图和数据显示，Script用Avenue语言编写宏（程序）。每个文件都有自己的窗口，本实验要求对View和Table进行操作。在Project窗口点击View，若View尚未高亮显示，则点击New。这样就打开了一个名为View1的视图窗口（图1-3）。
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图1-3　　　　打开了一个名为View1的视图窗口
3．在ArcView中每个文档都有其自己的菜单、按钮和工具，在窗口顶端排成三行，它们为用户提供了ArcView界面（图1-4）。按钮和工具是图标形式，代表了常用的菜单项，点击便能执行某种功能。点击后，工具按钮呈凹下状态，直到你再次点击或对激活的文件操作前，呈锁定状态。用鼠标将光标移到图标上时，名为ToolTip的短信息以一浮动黄色方框形式出现，告诉你该图标的功能。
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图1-4　　　　ArcView视图的菜单、按钮和工具
4．点击View菜单，出现下拉菜单和菜单选项。一些选项是清晰的，说明它们正处于激活状态，而另一些是模糊的，说明它们尚不能用。从View菜单选择Add Theme，或点击Add Theme按钮。Add Theme对话框允许你选择一个或若干个专题加到视图。ArcView用专题（Theme）这一术语表示一系列与属性相关的地图要素。Emidalat是一个格网专题，emidastrm.shp是一个要素专题。
5.Add Theme对话框显示驱动器、目录和数据源类型（图1-5）。首先，由驱动器和目录浏览到emidalat 和 emidastrm.shp。选择Grid Data Source 为数据源类型，双击emidalat使之加入视图。再次点Add Theme 按钮，这次选择Feature Data Source为数据源类型，并将 emidastrm.shp加到视图中。
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图1-5　　　　Add Theme对话框显示驱动器、目录和数据源类型

6．Emidastrm.shp 和emidalat 在View1窗口左侧的目录中出现。为了显示这些图层，在emidastrm.shp和emidalat 旁复选框打钩。ArcView将最后加入视图的专题图放在目录的最顶端，可通过拉动主题到一个新的位置来改变排列顺序（图1-6）。
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图1-6　　　　加入专题图后的视图窗口

7．点击目录中的emidastrm.shp以激活它。激活的主题会凸起显示。从Theme菜单中选择Table ，打开名为emidastrm.shp属性表，它显示了与emidastrm.shp有关的属性 (Emidalat 没有属性表， 因此，Table 菜单的项目是模糊的) （图1-7）。
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图1-7　　　　打开专题属性表
8．欲退出ArcView，首先关闭所有的文件和项目，从File下拉菜单中选择Close All以关闭所有文件，从File菜单中选择Close Project，并选择不存盘，再从File下拉菜单选择Exit以退出ArcView（图1-８）。
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图1-8　　　　退出ArcView
实验二　　空间数据输入与管理
实验类型：验证性实验
实验目的：通过屏慕数字化、属性数据的输入、表格的关联和连接、属性数据的分类计算等操作，掌握利用ArcView进行空间数据的输入与管理的方法。
实验内容：1.屏幕数字化

2.输入属性数据

3.表格关联和连接

4.属性数据的分类和计算

实验过程：

一、屏慕数字化

屏慕数字化时，需要一个图层（Shapefile或影像图）作为背景。本实验将从landuse.shp文件中数字化几个多边形，并成为一个新的Shapefile。

1．启动ArcView，打开一个新视图，将landuse.shp加入视图（图2-1）。从视图下拉菜单中选择Properties，对 Map Units（地图单位）和 Distance units（距离单位）均选“Meters”。landuse.shp以米为单位。
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图2-1    打开视图并加入背景图层
2．在目录中双击landuse.shp，打开图例编辑器，在Legend Type（图例类型）中选择Single Symbol（单一符号），并将Symbol（符号）的颜色做适当更改，然后点击Apply（应用）。修改符号颜色是为了与你将要数字化的新Shapefile区别（图2-2）。

3．从视图下拉菜单中选择New Theme。在下一个对话框中选择多边形作为Feature Type（要素类型），把这个新的shapefile取名为trial.shp，并指定其路径。注意此时在目录中trial.shp旁的方框是虚线，意为trial.shp处于编辑模式。双击trial.shp打开图例编辑器，将trial.shp符号改为黑色、外框号。

4．为了确保要数字化的要素会相交并完全对准，你需要使用交互捕捉选项。激活trial.shp，从Theme下拉菜单中选择Properties。在Theme Properties对话框中，点击目录表中的Editing，这就打开了Attribute Updating（属性更新）和Snapping（捕捉）两个对话框。在本实验中只需使用Snapping（捕捉）功能。选中Interactive，键入10m Tolerance（容差值），点击OK（图2-3）。10m捕捉容差值意味着当数字化两个距离在10m范围内的点（顶点）时，这两点将会捕捉在一起。
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图2-2    修改背景图层的图例
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图2-3    设置节点捕捉容差值
5.放大要数字化的区域，按下Draw Rectangle（画矩形）工具，在下拉菜单中选择Draw Polygon（画多边形）。有3个数字化选项：左击鼠标数字化点；右击鼠标弹出菜单，它包括诸如顶点捕捉、交互点捕捉等选项；双击则为完成数字化。从任一多边形开始数字化构成其边界的顶点，数字化最后的点必须回到起始点位置，在数字化最后一点时，右击鼠标选择顶点捕捉将终点和起点捕捉一起。

6．如果要数字化的多边形与已数字化好的多边形有一条公共边，这时不必对公共边数字化，只要将Draw Polygon（画多边形）工具改为Draw Line to Append Polygon（对添加多边形画线）工具即可，但用此工具时，数字化的起点和终点必须落在已存在的多边形之内。
7．当数字化完后，从Theme下拉菜单中选择Stop Editing（停止编辑），并保存编辑结果。

二、输入属性

1．接第一部分的实验，确认trial.shp处于激活状态，在Theme下拉菜单中选择Table打开其属性表.
2.添加字段。从Table下拉菜单中选择Start Editing，从Edit菜单中选择Add Field,依次添加两个字段（如图2-4）。
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图2-4    添加字段

3．输入属性。对照下表，点击Edit工具，然后点击要输入属性的单元格，依次输入属性值，结果如图2-5所示。
	ID
	TRIAL_ID
	LUCODE
	ID
	TRIAL_ID
	LUCODE

	2
	60
	200
	12
	68
	200

	3
	61
	400
	13
	71
	300

	4
	59
	400
	14
	67
	300

	5
	62
	200
	15
	66
	300

	6
	76
	300
	16
	74
	300

	7
	64
	300
	17
	72
	300

	8
	65
	200
	18
	73
	300

	9
	77
	300
	19
	69
	300

	10
	63
	200
	20
	70
	200

	11
	75
	200
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图2-5    输入属性数据

三、表格关联和连接

ArcView为属性数据管理提供了LINK和JOIN。
1．打开一个新视窗，添加wp.shp到视窗中，并打开其属性表。
2．确认项目视窗处于激活状态，点击Table和Add来打开Add Table对话框。确认对话框中的文件类型是dBASE。点击wpdata.dbf与wpact.dbf，将它们作为新表加进来。
3.用两表中的ID作为关联项，将wpdata.dbf关联到wp.shp属性表。点击wpdata.dbf中的ID和wp.shp属性表中的ID。然后从Table下拉菜单中选择Link。重复同样步骤，把wpact.dbf关联到wp.shp属性表。
4.点击wp.shp属性表中的一条记录，该记录高亮显示，同时wpdata.dbf和wpact.dbf中的相关记录以及wp.shp中被选中的地图要素也高亮显示（如图2-6）。
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图2-6    关联表后的属性查询
5．选择Table下拉菜单的Remove All Links移除所有关联关系。关闭表wpact.dbf，依次点击wpdata.dbf中的ID和wp.shp属性表中的ID。然后从Table下拉菜单中选择Join，连接wpdata.dbf与wp.shp属性表。结果wpdata.dbf中的属性数据合并到wp.shp属性表中，如图2-7所示。
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图2-7    表连接后属性数据合并到一张表中
四、属性数据的分类和计算

将连接后的表格中Elev字段的值分为4类：<=40、41—45、46—50和>50。

1．增加字段Elevzone（Number,2,0）用于保存分类结果。
2．点击Query Builder按钮，打开Query Builder Box。输入逻辑表达式：( [Elev] > 0) and ([Elev] <= 40 )，点击对话框中New Set。符合逻辑表达式的记录在wp.shp属性表中高亮显示（如图2-8所示）。关闭对话框。
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图2-8    查询结果高亮显示
3.从Field菜单中选择 Calculate来打开Field Calculator对话框。在显示区中输入1，点击OK。表中所有加亮记录都在字段Elevzone中有了值1，即被分类为Elevzone 1。
4．再次点击Query Builder按钮，输入逻辑表达式：( [Elev] > 40) and ([Elev] <= 45 )。点击对话框中New Set。打开Field Calculator对话框，在显示区中输入2，这样，Elevzone 2的分类就完成。
5．重复同样的步骤完成Elevzone 3和Elevzone 4。若要保存分类结果，在Table菜单中选择Stop Editing，并保存结果（图2-9）。
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图2-9   把分类结果存在新字段值中
6．在视图窗口中编辑wp.shp的图例，把属性分类结果反映到地图上（图2-10）。
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图2-10   分类结果图 
实验三　　矢量数据分析

    实验类型：验证性实验
实验目的：掌握利用ArcView对矢量数据进行空间分析的方法。
实验内容：1．缓冲区分析和叠加分析
2．距离量测
实验过程：
一、缓冲区分析和叠加分析

用缓冲区分析和叠加分析功能来为某水产养殖实验室寻找合适的地点：要求土地利用类型为灌木林地（landuse.shp中的lucode=300）；土壤类型为适宜开发的（soil.shp中的suit>=2）；必须离下水道管线300范围内。具体过程如下：
1．启动ArcView，添加Geoprocessing模块（图3-1）。
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图3-1    添加Geoprocessing模块
2．把分析要用的数据添加到视图（图3-2）。
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图3-2    添加分析数据到视图
3．选择菜单“View”>“Properties”，在View Properties对话框里将地图单位和距离单位设为m。

4．对下水道图层作缓冲区。激活sewers.shp，选择菜单“Theme”>“Create Buffers”。 在Create Buffers对话框中，确认想要作缓冲区的sewers.shp要素（图3-3），单击“Next”。指定缓冲区距离为300，单击“Next”。选择“Yes”以消除缓冲区之间的障碍，并将缓冲区结果以新的图层存盘。单击“Finish”，缓冲区被创建（图3-4）。

[image: image21.png]What do you want to bulfer?
€ The gieptics in o view

& [The Raiss of 2 hea)

Sewers sho

Number of fealures: &

Number offeatures selected: 0

I Use orly the selected features.

R





图3-3    确认缓冲区要素
[image: image22.png]Fle Edi View Theme Graphics Window Help

B 3 @BE]E BN SRS FEL) e
2] [7]

Scale 16011

of Suttr 1oiSemers =

off Semeisshe

of Landusests

O:

of sosst

0





图3-4    下水道缓冲区
5．叠加soil.shp和landuse.shp。选择菜单“View”>“GeoProcessing Wizard”，在“GeoProcessing”对话框中（图3-5）选择“Union two themes”，单击“Next”。在随后的对话框中，指定叠加的输入图层、叠加图层，并指定输出文件名（landsoil.shp）。单击“Finish”得到如图3-6所示的结果。
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图3-5    选择叠加方法
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图3-6    土地利用图与土壤图叠加结果
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3-7    叠加缓冲区后的结果图

6．叠加landsoil.shp和前面生成的缓冲区。“GeoProcessing”对话框中选择“Intersect two themes”，单击“Next”。在随后的对话框中，指定叠加的输入图层、叠加图层，并指定输出文件名（Finalcov.shp），单击“Finish”，得到结果如图3-7所示。

7．查询分析。

（1）打开Finalcov.shpr 的属性表，选择菜单“Table”“Start Editing” 使表可编辑。

（2）选择菜单“Edit”>“Add Field”给属性表添加字段suitable（图3-8）。
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图3-8    添加字段
（3）用Query Builder查询属性表。如图3-9所示，输入表达式后，单击“Add To Set”
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图3-9    用Query Builder查询
（4）计算属性。在主菜单中单击“Calculate”按钮，出现“Field Calculate”对话框。在对话框左下方表达式方框中输入1，单击“OK”（图3-10）。

（5）保存属性计算结果。选择菜单“Table”>“Stop Editing”，按提示保存表格。
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图3-10    计算属性

8．作边界融合处理。因为实验结果只需给出满足实验室选址要求的潜在地点，因此在其属性中只需保存“suitable”字段。

重新打开“GeoProcessing”对话框，选择“Dissolve features based on an attribute”（图3-11），在接下来的对话框中为融合指定融合主题、融合属性以及结果保存文件名。融合完成后得到满足某实验室选址要求的潜在地点分布如图3-12所示。
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图3-11   选择融合方法
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图3-12    满足某实验室选址要求的潜在地点分布视图
二、距离量测

用Assign Data by Location方法来量测deer.shp中的每个鹿场与edge.shp中原始林与皆伐区边缘的最近距离。

1．打开一个新视图，把deer.shp和edge.shp加到视图。从View菜单选择Properties，并指定地图单位的距离单位均为meters。
2．从View菜单选择Geoprocessing Wizard。在弹出的对话框中，选中Assign Data by Location按钮（图3-13）。点击Next。在出现的对话框中指定deer.shp为接受赋予数据的专题图，edge.shp为提供赋予数据的专题图。点击Finish（图3-14）。

[image: image31.png]2GeoProcessing

Choose a GeoPracessing operation, s anaC/ L seaion
then clck the Neatbuton t chooss This operation joins only the
optors. data for features of Theme2 to
the features of theme which

€ Dissolve fealures based on an attibute e e e

‘
- e
: Themel Theme2
i

(SpatialJoin) Tablel _Table2 Joined Table

About Assign Data by Location

Help. Cancel s Nest»>





图3-13   在 Geoprocessing Wizard 中选择距离量测方法
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图3-14    指定距离量测的相关专题图
3．激活deer.shp并打开其属性表。注意Distance和edge.shp中的字段已被加到专题属性表中。点击Query Builder按钮。输入查询表达式为（[Distance] <= 5)：这些位于与其靠近交界处50m范围之内的鹿场在专题属性表中以及视图中被加亮显示（图3-15）。
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图3-15    按量测距离查询专题图
实验四　　栅格数据分析

实验类型：验证性实验
实验目的：掌握利用ArcView对栅格数据进行空间分析的方法。
实验内容：1．局部运算、邻域运算
2．分带运算

3．自然距离量测

实验过程：
一、局部和邻域运算

1．启动ArcView并加载Spatial Analyst扩展模块。打开一个新视图，并将emidalat加到视图。从View下拉菜单选择Porperties并将地图单位设为meters。
2．从Analysis下拉菜单选择Map Calculatior。在弹出的对话框里，在Layers目录中双击emidalat，点击乘法（*）按钮，由键盘输入3.28（用于把高程数值由米转化成英尺）。你将在表达式方框内看到（[Emidalat] * 3.28）。点击Evaluate（图4-1）。
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图4-1    地图局部运算
3．该输出名称为Map Calculation 1，它以英尺显示emidalat。Map Calculation 1是临时格网。你可从Theme下拉菜单选择Save Data Set将该格网存盘，为其指定文件名和路径。
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图4-2    局部运算结果图

[image: image36.png]fiborhood Stati

swisic [Mean =]
Neighborhood Fleclangle =]
widh [3 o
Height [3 Cels
Units © Map ]
o Cancel





图4-3    设置领域运算方法
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图4-4    邻域运算结果
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图4-5    邻域运算结果格网属性

4．激活emidalat，从Analysis菜单选择Neighborhood Statistics。在Neighborhood Statistics对话框中，确定Statistic为平均值，Neighborhood为矩形，Width和Height均为3（单元）（如图4-3所示）。点击OK。带有单元值的滑动平均值的输出名称为NbrMean of Emidalat（图4-4）。对新格网专题的复选框打钩来观察视图,仔细观察新格网与Emidalat有何不同。确认NbrMean of Emidalat为激活状态，从Theme下拉菜单选择Properties。注意在Theme Properties对话框中（图4-5），新格网单元大小为30m，与emidalat相同。对话框还显示新格网具有Temporary状态。你可从Theme下拉菜单选择Save Data Set将该格网存盘，并指定文件名和路径。

二、分带运算

本实验用流域格网为分带格网，输入格网为年平均降水量格网，通过分带运算，在输出结果中按流域统计年降水量数据。
1．打开一个新视图，把流域格网hucgd和年平均降水量格网precipgd加到视图。在本运算中， hucgd为分带格网，precipgd为输入格网。
2．激活hucgd，从Analysis下拉菜单选择Summarize Zones。在弹出的对话框中，确认precipgd为要总结的专题（图4-6）。
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图4-6    确认要总结的专题
3．你可选任一个统计量来作图，这里选择平均值作图（图4-7），结果如图4-8所示。
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图4-7    选择平均值作图
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图4-8    各流域平均年降水量柱状图
4．Zone of Hucgd内Stats of Precipgd的表格按流域列出年降水量的统计值：最小值、最大值、值域、平均值、标准差、总和、种类、少数、多数和中值等（图4-9）。
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图4-9    按流域列出的年降水量统计值

三、自然距离量测
本部分实验要求你查找一种植物种类的潜在生长环境。Strmgd中的单元值是河流的ID值。elevgd中的单元值是高度带1、2和3。两个格网的单元分辨率均为100m。该植物种类的潜在生长环境必须满足这些指标：高度带为2，且与河流的距离在200m之内。

1．打开一个新视图，把strmgd和elevgd加到视图。从View下拉菜单选择Porperties并将地图单位设为meters。

2．创建离河流200m的距离带。激活Strmgd格网专题，从Analysis下拉菜单选择Find Distance，Spatial Analyst扩展模块创建了一个名为Distance to Strmgd的新格网。新格网以默认的分类系统出现（图4-10）。你可对格网重新分类，以建立距河流200m以内和以外两个距离带。激活Distance to Strmgd。从Analysis下拉菜单选择Reclassify。在Reclassify Values对话框里点击Classify，把类型数改为2，点击OK。接着在Old Values下点击第一个单元，把数字值域改为0-200；在Old Values下改变第二个单元值为201-2421，第三个单元保留No Data（无数据）不变（图4-11）。点击OK。
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图4-10    Distance to Strmgd的新格网视图
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图4-11    设置重分类值
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图4-12    Reclass of Distance to Strmgd的新格网视图
3．Reclassify功能把名为Reclass of Distance to Strmgd的新格网加到视图。该新格网只有三个数值：1、2和No Data。取值为1的单元为距离河流200m范围之内（图4-12）。

4．查询Reclass of Distance to Strmgd 和elevgd。从Analysis下拉菜单选择Map Query。在Map Query 1对话框的视窗范围内（图4-13），输入下列查询表达式：([Reclass of Distance to Strmgd] = 1.AsGrid) and ([Elevgd] = 2.AsGrid)。点击Evaluate。
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图4-13    在Map Query 1内输入查询表达式
5．查询结果显示在Map Query 1格网中（图4-14）。值为True（1）的那些单元满足所要求的两个指标。
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图4-14    查询结果图
6．如果不对Distance to Strmgd格网再分类，也能完成本实验。在此情况下，查询表达式必须改为：( [Distance to Strmgd] <= 200.AsGrid)and ([Elevgd] = 2.AsGrid)。
实验五　 空间插值与DEM的应用

实验类型：验证性实验
实验目的：掌握利用ArcView进行空间插值，并利用创建的格网DEM进行地形制图与分析。
实验内容：1．用IDW法进行空间插值
2．用两种样条函数进行插值并比较

3．利用格网DEM进行地形制图与分析
实验过程：
一、用IDW法进行空间插值

这部分实验先将xzq.shp转化成格网xzqgd；其次，用IDW（反距离权重）法并以xzqgd作为屏蔽掩模格网来创建高程格网。具体过程如下：

1．启动ArcView，添加Spatial Analyst扩展模块。打开一个新视图，把研究区的行政区数据（xzq.shp）和高程点数据（gaocheng.shp）添加到视图中，从View下拉菜单选择Porperties并将地图单位设为meters。
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图5-1    设置输出格网范围和象元大小
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图5-2    掩模格网视图xzqgd
2．创建掩模格网。掩模格网使空间分析只限在掩模格网范围内进行，在它范围之外的数据都设为No Data。激活主题xzq.shp，选择菜单“Theme”>“Convert to Grid”，在出现的对话框中设置输出格网范围和输出格网象元大小（图5-1），在接下来的Conversion Field对话框中选择Shima作为单元值并点击OK。你不要把要素属性加到xzqgd，但你必须把xzqgd加到视图中，如图5-2所示。

3．设置空间分析属性。选择菜单“Analysis”>“Properties”，在出现的分析属性框中设置空间分析范围、分析象元尺寸以及分析掩模格网，如图5-3所示。
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图5-3    设置空间分析属性
4．空间插值。激活gaocheng.shp主题，选择菜单“Surface”>“Interpolate Grid”，在出现的对话框中设置空间插值方法为反距离权重插值法（IDW），并指定用于插值的属性，这里是“Elev”，其他参数按默认值（图5-4）。单击“OK”后，系统开始进行插值计算，这时视图底部会出现处理进程条，插值完成后自动把插值结果加入到当前视图中来，如图5-5所示。
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图5-4    设置插值方法为IDW
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图5-5    用IDW插值法创建的高程格网
5．修改分类数和颜色方案。由图5-5 可以看出，插值结果生成的格网类型较多，你可以通过修改图例来减少其分类。双击插值结果主题，在图例编辑器中单击“Classify”，在出现的“Classification”窗口中可设置新的分类数，确定后退回到图例编辑器中，在此还可选择适当的颜色方案（Color Ramps），然后单击“Apply”使新图例生效。

6．保存格网DEM。激活插值结果主题，选择菜单“Theme”>“Save Data Set”，把插值结果保存为一个格网（Idw），选择Theme 下拉菜单Properties，在Theme Properties对话框中把格网名称改为Idw。

二、用两种样条函数进行插值并比较
1．用规则样条方法创建插值格网。激活gaocheng.shp主题，选择菜单“Surface”>“Interpolate Grid”，在出现的对话框中设置空间插值方法为样条函数插值法（Spline），指定用于插值的属性是Elev字段，在Type中选择Regularized，点击OK（图5-6）。插值结果如图5-7所示。
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图5-6    设置插值方法为规则样条函数
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图5-7   用规则样条函数插值法创建的高程格网
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图5-8    设置插值方法为张力样条函数
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图5-9   用张力样条函数插值法创建的高程格网
2．保存插值格网为Regularized，并在Theme Properties对话框中把格网名称改为Regularized。

3．用张力样条法创建插值格网。再次激活gaocheng.shp主题，选择菜单“Surface”>“Interpolate Grid”，在出现的对话框中设置空间插值方法为样条函数插值法（Spline），指定用于插值的属性是Elev字段，在Type中选择Tension，点击OK（图5-8）。插值结果如图5-9所示。
4.保存插值格网为Tension，并在Theme Properties对话框中把格网名称改为Tension

5．比较Regularized和Tension这两个格网。从Analysis菜单中选择Map calculator。在Map calculator的表达式方框中输入下列语句：( [Regularized] - [Tension])。点击Evaluate（图5-10）。
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图5-10    Map calculator 对话框
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图5-11    用规则样条法与张力样条法创建的高程格网之差别
6.名为Map calculation 1 的输出结果显示Regularized和Tension之间单元数值的不同。为了更好比较这这两种格网，可用一种新的图例。双击Map calculation 1主题打开其图例编辑器。在Legend Editor对话框中，点击Classify并把类型数改为4。接着把四个类型数值改为-500～-300、-300～0、0～300和300～600。把Color Ramp（颜色渐变方案）改为蓝至红二色。点击Apply,得到结果如图5-11所示。

7．你可以详细检查Regularized和Tension的单元值。同时激活gaocheng.shp、Regularized和Tension。放大一个小区域。用Identify工具点击地图上某个点。Identify Results对话框包括三个专题，通过加亮显示每个专题，你可读出估算值和最近高程点的已知值。如果你点击的地点接近某个已知高程点，这三个数应该彼此相近。

三、利用格网DEM进行地形制图与分析

这里以前面用IDW方法创建的高程格网为例来进行地形制图与分析。
1．创建等高线专题图。激活IDW格网，从Surface下拉菜单选择Create contours，输入等高距为100，基础等高线为0，点击OK（图5-12）。得到等高线如图5-13所示。
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图5-12    设置等高线参数
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图5-13    从IDW高程格网上创建的等高线图

2．创建晕渲专题图。激活IDW格网，从Surface下拉菜单选择Compute Hillshade。选取方位角为默认值315，高度角为默认值45，即创建的晕渲专题图的光源来自西北方向，与地平面呈45度夹角。点击OK（图5-14）。创建的晕渲图如图5-15所示。
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图5-14    设置晕渲参数
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图5-15    由IDW格网创建的晕渲专题图

3．创建坡度图。激活IDW格网，从Surface下拉菜单选择Derive Slope，即生成坡度图（图5-16）。坡度图是浮点型格网，默认分类是9个以度为单位的类型。你可根据需要对其进行新的分类。从Analysis菜单选择Reclassify可对坡度进行重分类。
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图5-16    由IDW高程格网生成的坡度图
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图5-17    由IDW高程格网生成的坡向图（八个方向）

4．创建坡向图。激活IDW格网，从Surface下拉菜单选择Derive Aspect，即生成坡向图（图5-17）。这里的坡向图以9个类别显示：平坦、北、东北、东、东南、南、西南、西和西北。但坡向格网实际上是浮点型格网，没有专题属性表。你可用Analysis下拉菜单中的Reclassify把坡向格网转成整形格网，或改变坡向的分类(图5-18)。例如，由八个方向变成四个基本方向（图5-19）。
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图5-18    修改坡向图的分类
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图5-19    由IDW高程格网生成的坡向图（四个方向）

实验六　　ArcView GIS综合应用
实验类型：综合性实验
实验目的：掌握如何综合利用ArcView GIS的功能构建合适的模型来解决具体的应用问题。
实验内容：1．用二值模型确定某种植物的潜在生境
2．用指数模型进行地下水脆弱性分析
实验过程： 
一、用二值模型确定某种植物的潜在生境

本部分实验与前面自然距离量测中的实验目标一样，但这里用的是矢量数据，要求你用矢量数据构建二值模型来确定某种植物的潜在生境。这个潜在生境必须满足以下指标：在高度带2之内；距离河流200m之内。

1．启动ArcView，加载Geoprocessing扩展模块。打开一个新视图，把分析所要的数据（elevzone.shp和stream.shp）添加到视图（图6-1），并把View Properties中的地图单位和距离单位设为米。
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图6-1    把分析所要的数据添加到视图
2．对河流做200m缓冲区。激活stream.shp，从Theme菜单选择Create Buffers。在Buffers对话框内，确认要作缓冲区的要素为stream.shp。点击Next。设定指定距离为200m，点击Next。点击Yes消去缓冲区内的界线，将缓冲区结果存盘并命名为strmbuf.shp。点击Finish。strmbuf.shp以Buffer1 of stream.shp出现在目录表中（图6-2）。从Theme下拉菜单选择Properties，把Buffer1 of stream.shp重命名为strmbuf.shp。
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图6-2    河流的200缓冲区
3．把elevzone与strmbuf.shp叠加。在View菜单的Geoprocessing向导下选择Intersect Two Themes。在弹出的对话框中选择strmbuf.shp作为相交的输入专题，elevzone.shp为叠加专题，指定相交后的输出图层为pothab.shp（图6-3）。点击Finish。
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图6-3    叠加结果图
4.查询pothab.shp并在高度带中选择区域。打开pothab.shp的专题属性表，点击Query Builder按钮。在Query Builder对话框中设定逻辑表达式为：zone = 2，并点击New Set。pothab.shp的专题属性表中满足条件的潜在生境被加亮显示（图6-4）。
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图6-4    满足条件的查询结果
5．通常要把这种二值模型的结果保存为新专题，以便对其做进一步分析。激活pothab.shp，从Theme下拉菜单选择Convert to Shapefile。在弹出的对话框内，为新专题指定路径和名称，点击OK。
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                        图6-5    保存为新专题的结果视图
二、用指数模型进行地下水脆弱性分析

本部分实验用栅格数据建立指数模型来模拟一个地下水脆弱性分析项目。该项目设想地下水脆弱性与三个变量有关：土壤特征、地下水埋深和土地利用。每个变量的评分系统为0～50。例如，地下水埋深为1～25ft、26～50ft、51～100ft和101～250ft的各类型相应得分为50、35、20和10。土壤格网Soil_gd中的单元值代表土壤得分，土地利用格网landuse_gd的单元值代表土地利用得分，地下水深格网depwater_gd中的单元值代表地下水埋深得分。三个格网的单元分辨率均为90m。landuse_gd中的城市和建成区赋值为99，将不纳入本模型。本项目假设土壤因素比其它两个因素更重要，因而赋值为3，其它两个因素赋值为1。因此该指数模型可表达为：
指数值 = 3 土壤得分 + 土地利用得分 + 地下水埋深得分

1．添加Spatial Analyst扩展模块。打开一个新视图，把Soil_gd、landuse_gd和depwater_gd加到视图。

2．由于landuse_gd中的城市和建成区不纳入本模型，因此要先把landuse_gd中的99改为No Data。激活landuse_gd。从Analysis菜单选择Reclassify。在Reclassify Values对话框中，在New Value的第一单元中输入20，在接着的三个单元中输入40、45和50。然后在下两个单元中输入No Data。点击OK。名为Reclass of landuse_gd的新格网加到了视图中（图6-6）。Reclass of landuse_gd的单元值应为20、40、45、50和No Data，见图6-7。
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图6-6    把landuse_gd中城市和建成区设为No Data
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图6-7    Reclass of landuse_gd的新格网视图
3．从Analysis菜单选择Map Calculator，从Soil_gd、Reclass of landuse_gd和depwater_gd计算指数值。在Map Calculation 1对话框的视窗范围内输入下列表达式： [Soil_gd] * 3 + [Reclass of Landuse_gd] + [Depwater_gd]（图6-8）。点击E。名为Map Calculation 1的新格网加到了视图中，即表示指数模型的格网（图6-9）。
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图6-8    利用Map Calculator计算指数值
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图6-9    地下水脆弱性指数格网
4．Map Calculation 1的指数值域为145.2～250。你可以把其值域转为0～1。从Analysis菜单选择Map Calculator来转化指数值域。在下一个对话框中，输入计算语句为：( [Map Calculation 1] - 145.2 ) / (250-145.2)。名为Map Calculation 2的输出结果显示其值域为0至1。
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图6-10    利用Map Calculator转化指数值域为0～1
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图6-11    值域为0～1的地下水脆弱性指数格网
附录：课程实验大纲

《ArcView GIS 应用》实验教学大纲

课程名称：ArcView GIS 应用
课程总学时：30

课程总学分：2
实验学时：15
适用专业及年级：生态学专业  三年级

开设实验项目数：6
本大纲执笔人：叶金玉        
一、实验目的与基本要求

1．实验目的

实验教学是本课程的重要环节。本实验课的主要目的是，通过15学时实验课的学习，让学生熟悉ArcView GIS软件的基本操作，掌握其基本功能以及空间分析模块的主要功能，并能用这些功能来解决具体的应用问题。
2．基本要求

（1）熟悉ArcView GIS软件的常用菜单、按钮和工具的操作，能熟练地用其Project来组织不同的文档，并能用View中的目录来组织不同的专题。
（2）掌握利用ArcView GIS软件进行实验数据的输入与管理、处理与分析、空间插值、DEM的地形分析与制图等主要功能，并能综合利用这些功能来分析、解决实际问题。
（3）实验课前应阅读实验指导手册中相应的实验课程部分，明确实验课程的目的、内容和要求；实验过程中的具体操作应按指导手册的规定进行，如遇问题要及时向指导教师提出，注意记录实验过程现象和结果；实验课后及时完成实验报告并上交给指导教师，实验报告包含实验目的、实验内容、实验过程和步骤，综合性实验还应包括实验结果分析。

二、实验项目内容与学时分配
	序号
	实验项目名称
	实  验  内  容
	学

时
	实验要求
	实验类型
	每组人数

	1
	ArcView GIS入门
	1． 启动ArcView并创建一个空Project；

2． 了解Project是如何组织它的不同文档的；

3． 创建一个View并添加Theme,了解常用的菜单、按钮和工具，熟悉View中的目录如何组织不同的Theme；

4． 退出ArcView
	6
2
	必
必做
	验证
	1

	2
	空间数据输入与管理
	1． 屏幕数字化

2． 输入属性数据

3． 表格关联和连接

4． 属性数据的分类和计算
	3
	必做
	验证
	1

	3
	矢量数据分析
	1． 缓冲区分析

2． 叠加分析

3． 距离量测
	6
2
	必
必做
	验证
	1

	4
	栅格数据分析
	1． 局部运算、邻域运算

2． 分带运算

3． 自然距离量测
	6
2
	必
必做
	验证
	1

	5
	空间插值与DEM的应用
	1． 用IDW法进行空间插值

2． 用两种样条函数进行插值并比较

3． 利用格网DEM进行地形制图与分析
	6
2
	必
必做
	验证
	1

	6
	ArcView GIS综合应用
	1．用二值模型确定某种植物的潜在生境
2．用指数模型进行地下水脆弱性分析


	4
	必做
	综合
	1


三、实验成绩考核办法

该门课的目的是让学生掌握ArcView GIS软件的使用，因此在考核时主要考查学生对本软件使用的熟悉程度，因此常把实验成绩作为该门课的成绩，即100分。具体考核办法是平常的上机表现占40%，即40分，期终的上机考试占60%，即60分。
四、实验教材和参考书

实验教材：陈健飞等译.地理信息系统导论.科学出版社,2003.
参考书：

1.汤国安,陈正江,赵牡丹等.ArcView 地理信息系统空间分析方法.科学出版社,2002.
2.张新长编译.ArcView GIS应用软件教程.福建省地图出版社,2000.
3.秦其明,曹五丰,陈杉编著.ArcView地理信息系统实用教程.北京大学出版社,2001.
五、主要使用的仪器设备

1．硬件设备：计算机、打印机；
2．软件设备：系统软件是Windows 2000或Windows XP，专业软件是ArcView。
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